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1 Introduction 
 
Today’s course outlines the procedures for processing Administration Manager Year End.  Certain 
steps assume that users have been provided with the SIS Backup Wizard for copying the current 
year’s data files.  If you do not have this application please contact Customer Service Centre 
(contact details below) before proceeding with the Year End process. 

Customer Service Centre (CSC)  

Phone (CSC) Metro: 9264 5555 Country: 1800 012 828 

Fax (CSC) 9264 4701 

Please include your ID number, contact details and a brief description of the problem. 

Much of the Year End process can be set up in Term 3 or early in Term 4 with the final Year End 
being run at a time that suits the school. That is, either at the end of the current year or at the 
beginning of the next year. 
 

IMPORTANT: 

These training notes are intended for use in the SIS Admin Year End 
Training course.  SIS users should use the Admin EOY Fact Sheet when 

completing the End of Year process. 
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1.1 Course Outline 

Time Content 

8:45 a.m. Coffee and Introductions 

9:00 a.m. Introduction to Administration Manager 

Year End 

Updating the datafile 

Creating a checklist for Forms 

Assigning a Leavers year 

Backing up the datafile  

School calendar 

Define Semester/Timetabling Periods  

Form descriptions 

Set up Leavers 

Increment proposed years and forms 

Reports for proposed years and forms  

Student lists for Reference 

Process Year End 

 

10:30 a.m. Morning Tea 

10:45 a.m. Check Year End  

Process Admissions Students 

Move External Roll Students to the Former Roll 

Update Form Descriptions  

Changing Student FTE  

Check repeating students 

Assign Family Representatives 

Print State Archives Report 

Set up New Attendance Year  

Notification of Transfer 

Check student’s Destination School 

Purge Audit Trails 

 

12:00  Close 
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1.2 Logging on to the System 

Activity: 
 
To log on, double click on Integris Training on the desktop 
 

 
 
Type ADMIN as the User Name <Tab>  
Enter the Password: keys 
 

 
 

Click on Login or press <Enter>  
 

 
In schools, each user has their own user name and password, which enables access to particular 
sections of the software as determined by the school administration. 

Note: It is strongly recommended that you change your password once a month. 
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1.3 Help Contents and Index 

Activity:  

Top Toolbar > Help > Help Contents and Index 

 
 
Double click Integris Administration Manager Help 
View  
Close Help 

 

 

IMPORTANT  

RM Billing Schools must not perform the RM Billing End of Year 
process until: 

         The Administration Manager year-end process has been completed; 
and 

     The system is in the new year (that is, the date must be on or after 1 
January 2017) 

Refer to the RM Billing End of Year Fact Sheet for further information. 
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2 Checklist for Year End Processes 
The following list outlines the steps involved in the Year End process. Much of the process can be 
set up early in Terms 3 or 4, with the final Year End being run at a time that suits your school that 
is either at the end of the current year or the beginning of the next year. 
 
Tick each step as it is completed. 
 

Step Function Completed 

1. Bring your datafile up to date  

2. Print form lists for all forms and years  

3. Check Intake year for Secondary Schools  

4. Check the leavers year in School Details   

5. Back up the datafile  

6. Set up the school calendar for the new year  

7. Defining Semester/Timetabling Periods  

8. Set up form descriptions for the new year  

9. Set up Leavers  

  10. Increment students’ proposed years and proposed forms  

11. Print reports showing proposed years and forms   

12. Print student lists for future reference  

13. Back up Data File  

14. Process Year End  

15. Check Year End was successful  

16. Process Admissions Students  

17. Move External Roll Students to the Former Roll  

18. Changing Student FTE  

19. Update Staff Details  

20. Update Form Descriptions  

21. Repeating Student; check they are flagged  

22. Assign Family Representatives  

23. Print State Archives Report  

24. Set up New Attendance Year  

25. Notification of Transfer  

26. Checking Student’s Destination School  

27. Purge the Audit Trail  

 

Part A Can be completed prior to 15th December 22015 

Part B To be completed after 15th December 2016 
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3 Year End Process 

4 Step 1: Bring your Datafile up to Date 
This means that students who are coming to the school next year have been added to the 
Admissions Roll and students who have left have been moved to the Former Roll.  If the Lesson 
Attendance module is being used, make sure attendance data is up to date. The following activities 
will cover these tasks. 

IMPORTANT  

Do not move leavers to the Former Roll.  This is carried out 
automatically when processing the year end. 

 

Activity: 
 

General > Student Details 

Moving a student to the Current Roll 

A student on the Admissions roll, Wendy Ballarat, has started at the school and needs to be moved 
to the Current Roll. 
 

 Change the Roll Status to Admissions 
 

 
 
Find Wendy Ballarat  

 

 
 

 Type the first three letters of her surname, followed by a comma 
 

 Press <Enter> 

 Click Edit   
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 Check the Accepted  box 

 Allocate her to Form Room 1 

 Allocate her a House 
Complete her address details 
 

 
 

 Go to the Miscellaneous Tab 

 Enter her immunisation details as shown below 
 

 
 

 Click OK 

 Click Yes 
View the Accepted Icon 
 

 
 

Note:  An accepted icon  will appear in the Student window in the bottom task bar.  
The Speed Edit function can be used to edit the Acceptance Status (Admissions) for more 
than one student. 
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Admin > Utilities 

 Double-click Admissions Transfer  to Current Roll 

 Select Transfer all students with Acceptance Status of Yes, ignoring any Entry Dates that 
have been entered. 

 

 
 

 Use TODAY’S date as the Enrolment Date 

 Click Next 
 

 
 

 Click  Finish 
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 Click OK 
 
 

 
 

  Click No to check for empty batches 
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Activity: 

General > Student Detail 

Moving a student to the Former Roll 

 

Linda So is leaving the school today.  Move her to the Former Roll.   
 

 Ensure the Roll Status is Current   
 

 Find Linda So 
 

 
 

 Click on Move Student to Former Roll  

 

 
 

 Click Yes 

 Enter TODAY’s date and the following 
 

 
 

 Click OK and Yes to remove the student from their groups 

 Enter TODAY’s date regarding changes to the roll status  
 

 
 

 Click OK  
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Note:  The default date is the date up to when the Daily Records have been created.  At 
school, the date entered would be the date the student actually left. 

 Remove Linda from her cohort by clicking   
 

 
 
 

 
 

 Click Yes  to the message 

Note: By clicking on  rather than using the Remove from Cohort feature, a report is 
created in Timetabling which lists her subjects and teaching sets.  If the student returns to 
the school, they may be reinstated rather than re enrolled. 
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Activity: 

General > Student Details 

Moving Multiple Students to the Former Roll 

 
Cameron Smith and Kane Smith are moving to Jurien Bay, so they need to be moved to the 
Former Roll. 
 

 Ensure the Roll Status is Current 
 

 Find Cameron Smith     
 

 Right click in the Contacts area 
 

 
 

 Choose Make Siblings the Browse Set 
 

 Click Edit  
 

 Click on the Additional tab  
 

 Enter today’s date as the Leave Date and Jurien DHS as the Destination 
 

 
 

 Click OK 
 

 Click Next Student  

 Enter the same Leave Date and Destination  for Kane’s records 

 Click OK 
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Admin > Utilities 

 Double-click Current Roll to Former Roll 

 Enter TODAY’S date 
 

 
 

 Click OK 
 

 
 

 Click Yes 
 

 
 

 Click Yes  

Note:  If Daily Records have been created for the day in question, a message will be 
displayed showing that Attendance Records are being deleted 

 

 
 

 

 
 

 Click OK  
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Note:  If one of the students being moved to the Former Roll was the Family Representative, 

the following message will display. 

 

 
 

 Click OK  
 

 

4.1 Step 2: Print Form Check Lists for all Forms/Years 

 
It is recommended that users create a checklist for each Form/Year Group in order to show current 
and Proposed Forms/Years.  
 
Setting up this report as follows will produce a checklist for use with the Year End process. Use the 
lists to record proposed forms against current forms.  
 
For each form group: 
 

 Write the name of the student’s new (proposed) form against the current form. 

 Mark the names of individual students who will be moving to forms/years that are different from 
the proposed form/year for the remainder of students in the list. 

Note:  Some students may be repeating their current year. 

 On the lists, mark as Leaver any students in the Leavers year (for example, Year 6 in primary 
schools for 2016 and Year 12 in secondary schools), as well as any other students who will be 
leaving.  

  



 
 

 
 2016 Integris Admin Year End Training Notes .docx 28-Jun-16 

Page 21 of 96 

© 2016 Civica Education Pty Ltd 
 

Activity:  

WA Reports > Reports > WA Reports > Standard Student Check List 

 Enter Proposed Year and Form as the Title  

 Directions to staff may be added in the Footer 
 

 
 

 Click the Sort  tab  

 Double click Form then Year 

 Check Total and Page against Form 
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 Click the Select  tab and choose Form option 
 

 Click  Select All to highlight all forms 
 

 
 

 Select the Includes tab  

 Check Form Teacher(s), Student Form, Student Year Group (in that order) 
 

 
 

 Tick the first two columns and enter the column labels:  2017 Form and 2017 Year 

 Enter the columns widths of 3 cm 
 

 
 

 Print  to the screen then close the report 
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In order to use this checklist again, users can save it as a custom report by clicking on the blue 
folder at the top of the screen. 
 

 Click on the blue folder  
 

 Enter a name for the custom report 
 

 
 

 Click OK 

 Print the report to the screen 
A portion of the report is displayed below 

 

 
 

Note:  Report can be accessed for later use via: WA Reports > Reports > Custom 

Reports 
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5 Check the Intake and Leaver’s Years  
Schools will need to check the Start Year Group and End Year Group are correct in General >  

Control > Preferences > Year Groups.  It is advisable to do this prior to commencing the Year End 
Process. The Intake Year and Leaver’s Year must also be checked in General > School Details 
 

5.1 Step 3: Year Groups 

 

Activity: Check the Start Year Group and End Year Group 
 
General > Control > Preferences > Year Groups 

 
Secondary schools should check the Start Year Group is correctly set up to start with Year 7 (as 
shown below). Primary Schools should check that End Year Group is Year 6. 
 

 
 
Click Cancel as we will not be making any changes to Year Groups in Training 
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5.2 Step 4: Check Intake and Leaver’s Year 

Activity: 
 
General > School Details 

 
Secondary schools should check the intake year is correctly set up to start with Year 7. Primary 
Schools should check that the Leavers Year is Year 6. 
 

  
 
In a District High School, the intake year will start with Year group K 

 

 
 

Note: If the Intake or Leaver’s Year is incorrect, it must be edited in School Details. 
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6 Step 5: Back up the Datafile 
 
It is necessary to make a copy of the datafile as it stands before you set up a new academic year, 
in case you inadvertently delete the current year’s data. This involves making a copy of the current 
year’s datafile and storing it in a folder where it is accessible if needed.   
 
The SIS Backup Wizard or Safe Backup should be used to make a backup of your data at this 
time. 
 
Ensure all users are logged out of Integris and the datafile is in Single User Lock prior to using the 

SIS Backup Wizard. Instructions for using the SIS Backup Wizard can be found in the K:\Inst\SIS 
Backup Wizard folder. 
 

Safe Backup and Single User Lock documentation can be found on the STIMS website 
 
http://det.wa.edu.au/intranet/stims/detcms/intranet/student-information-management-system/sis-
administration/administrator-manager-module/general/general-fact-sheets.en?oid=MultiPartArticle-
id-10935290 
 
 

IMPORTANT:  

You will be asked to repeat this backup prior to processing Year End 
(Step 13) because of changes you have made to the datafile between 

now and then. 

  

http://det.wa.edu.au/intranet/stims/detcms/intranet/student-information-management-system/sis-administration/administrator-manager-module/general/general-fact-sheets.en?oid=MultiPartArticle-id-10935290
http://det.wa.edu.au/intranet/stims/detcms/intranet/student-information-management-system/sis-administration/administrator-manager-module/general/general-fact-sheets.en?oid=MultiPartArticle-id-10935290
http://det.wa.edu.au/intranet/stims/detcms/intranet/student-information-management-system/sis-administration/administrator-manager-module/general/general-fact-sheets.en?oid=MultiPartArticle-id-10935290
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7 Step 6: Set up the School Calendar for the New Year 
It is critical when setting up the School Diary in SIS for 2017 that the term dates are entered 
correctly.  Errors in the School Diary will have an impact on Lesson Attendance accuracy and on 
the timetable in secondary schools using the Timetable Module. 
 

Term dates may be accessed from the Department’s website: 
http://www.det.wa.edu.au/education/termdates/ 
 

Public Holidays may be accessed at the following website: 
http://www.det.wa.edu.au/education/termdates/holidays.html 
 

7.1 Term Dates and Public Holidays For 2017 

Notes:  These dates are accurate as of 27th June 2016. Please check with DoE and your 
school Administration Team for confirmation of School Development Days and student 

start dates.  

When establishing the Terms in the SIS School Diary, ALL Terms MUST begin on a Monday 
and the days where students are not required to attend should be marked as either Public 

Holidays or School Development Days as appropriate. 

Term 1, 2017 

Monday 30 January – Friday 7 April  

Students Return Wednesday 1 February 
School Development Days  2 Days before students return 

Term 2, 2017 

Monday 24 April – Friday 30 June  

Students Return Monday 24 April 

School Development Days  Dates determined by the school 
Term 3, 2017 

Monday 17 July – Friday 22 September  

Students Return Monday 17 July 

School Development Days Dates determined by the school 

Term 4, 2017 

Monday 9 October – Thursday 14 December  

Students Return Monday 9 October 

Students Finish Thursday 14 December 

School Development Days  Dates determined by the school 

 
  

http://www.det.wa.edu.au/education/termdates/
http://www.det.wa.edu.au/education/termdates/holidays.html
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The Public Holidays for 2017 are: 
 

PUBLIC HOLIDAY DATE 

New Year’s Day Sunday 1 January 

Australia Day Thursday 26 January 

Labour Day Monday 6 March 

Good Friday Friday 14 April 

Easter Monday Monday 17 April 

ANZAC Day Tuesday 25 April 

WA Day Monday 5 June 

Queen’s Birthday Monday 25 September 

Christmas Day  Monday 25 December 

Christmas Day Observed Monday 25 December 

Boxing Day  Tuesday 26 December 

Boxing Day Observed Tuesday 26 December 

Notes: The Public Holidays falling during term have been highlighted. 

When New Year’s Day, ANZAC Day or Christmas Day fall on a Saturday or Sunday, the next 
following Monday is also a public holiday.  When Boxing Day falls on a Sunday or Monday, 
the next following Tuesday is also a public holiday.  
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7.2 Set up the School Calendar for the New Year 

Activity:  

General > School Details 

IMPORTANT 

Always make a copy of your data file prior to setting up a new year, in 
case you accidentally overwrite data. 

 

 Click Display School Diary     

 Click on Set up School Year   
 

 Click Display Diary for Specified Year to double check that the following year has not 
already been set up 

 

 
 

 Select Set up year structure and click OK 
 

 
 
The School Year window will be displayed, showing this year’s terms. 
 

 Enter the Year in the School Year field   
 

 <Tab> out 
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 Click Yes 
 

Note: This deletes last year’s term dates, but does not affect the current year diary. 

 Overtype the I Inset Code  to read S School Development 
 

 to  
 

The new term dates can now be entered. 
 

 

IMPORTANT 

 The Start Dates for each term are always set to the Monday of the first 
week of school regardless of which day the students start attending.   
Starting a term on any day other than a Monday has implications for 

Lesson Attendance and Timetabling.  Any days that the students do not 
attend can be marked using the Closed code. 
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 Click Add Term   
Enter the following: 

 

 
 

 Click OK 
 

 Repeat to add the remaining terms for the year 

 Click Add Term   
 

Term 2 Mon 24 April – Fri 30 June 

Term 3 Mon 17 July – Fri 22 Sept 

Term 4 Mon 9 Oct – Thurs 14 Dec 

 

 
 

Note: These dates were correct at the time of printing.  Please refer to 
http://www.det.wa.edu.au/education/termdates/to confirm dates prior to input. 

 Click  and close the School Year window  
 
 

 

Important:  Terms are always entered as starting on a Monday.  If the 
school is not open on the Monday, it may be entered as a closed day in 

the School Diary. 
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7.3 Add School Development Days and Public Holidays 

 

Activity: 

 In the School Diary window click on Toggle Paintbrush   
 

Click in the green School Development cell 
Scroll down to the 30th January 
Enter Mon 30th Jan and Tues 31st  Jan as School Development days 

 

 
 
 

Hint:  Click on the actual date.  This will highlight all 3 cells.  To correct an error, click in  the 

white cell, click on the error and reselect the correct colour code 

 

 
 



 
 

 
 2016 Integris Admin Year End Training Notes .docx 28-Jun-16 

Page 33 of 96 

© 2016 Civica Education Pty Ltd 
 

 

 Click in the blue Holiday  cell 

 Use the blue chevrons  to navigate to March 
Enter Mon 6th  as a public holiday 
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Navigate to April 
Enter Tuesday 25th April  as a public holiday 

 

 
 
Navigate to June 
Enter Monday 5th June as a public holiday 
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Navigate to July 
Change the Paintbrush Code to School Development 
Mark 17th July as a School Development Day 
 

 
 

Turn the paintbrush off  and Close 
 

Note: These dates were correct at the time of printing.  Please refer to 

http://www.det.wa.edu.au/education/termdates/to confirm dates prior to input. 
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8 Step 7: Defining Semester/Timetabling Periods 

General > School Details > Timetabling Periods 

Timetabling Periods are required for Timetabling and are used for calculating the number of 
student half day absences in Formal Reports.  Terms dates must be entered in the School 
Calendar before Timetabling Periods can be created. 
 

Selecting the  icon will create semester dates. 

Selecting the  icon will create term dates. 
 

Selecting  will allow users to create customised Timetabling Periods.   Schools using 
Timetabling will create the Timetabling Periods they require.  Schools not using Timetabling will 
use the semester Timetabling Periods to enable the reporting of half day absences in Formal 
Reports. 
 
 

ACTIVITY: 

General > School Details 

Define Semesters 1 and 2  

Click on Timetabling periods  
Ensure 2017 is selected 

Click on Create Semesters from School Diary   to create semester periods 
 

 
 

 

IMPORTANT 

 All dates MUST start on a Monday.  If any start date is NOT a Monday, 
please call the Customer Service Centre on 926 4555 (Metro Schools) or 

1800 012 828 (Regional Schools)  
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9 Step 8: Set up Form Descriptions for the New Year 
If additional Form Classes need to be set up for the following year, these need to be created before 
students can be allocated to them. 

IMPORTANT:  Do not allocate teachers at this time 

 

Activity: 

General > Parameters > Form Description 

 

Note:  Do not edit or delete the Not Specified parameter. If there is no Not Specified 
parameter in the list, contact your Customer Service Centre (92645555 for metropolitan 
schools and 1800 012 828 for country schools) before proceeding.  

Click Add   
Enter the Form Description: Room 7  (skip the first field Form Code) 

 

 
 
 
Click OK and Close 
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10 Step 9: Speed Edit Leaver’s Details 

IMPORTANT 

The processing of leavers is a 2 part function. The first part (Step 9) is where the 
Leavers’ dates and destinations are entered; the second step (Step 10) is where the 
Leavers are allocated a proposed year and form and then moved to the former roll 

as part of the End of Year process. 

 

Use Speed Edit to enter a Leave Date and Destination for your top year group for 2016, and for 
all students who will not remain at the school. This includes Year 6 students in a primary school, 
Year 10 students in a District High School and Year 12 students in a Senior High School as well 
as any other students known to be leaving at the end of the academic year. 
 
To ensure that both the Destination and Leave Date are saved correctly in Speed Edit, enter the 
Destination first, followed by the Leave Date, saving each separately as you go. 
 
If the destination is unknown, use the value Not Specified or Other Sources.  If the destination is 

known but is not in the list, contact the Customer Service Centre on 9264 5555 (metro schools) 
and 1800 012 828 (regional schools) 
 

IMPORTANT 

Do not use speed edit to set up proposed years or forms, as this will 
prevent the Year End Process functioning correctly. 
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Activity:  

Admin > Speed Edit 

 Find  the students in Year 12 

 Change Area to Destination 

 Click Select All 
 

 
 

 Select the New Value of Not Specified 
 

 
 

 Click Apply Changes  
 

 Click  
 

 
 

  Click Yes 
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 Select Leave Date from the Area drop down menu 

 Click Select All 

 Enter the New Value as 4 Nov 2016 
 

 

Note:  Each school will determine the appropriate Leave Date for their Year 12 students. 

 Click Apply Changes  
 

 
 

 Click  
 

 
 

 Click Yes 
 

Note: Not Specified is only used for Year 12 leavers.  All other leavers including Year 6’s 
going to High School and Year 10’s moving from District High Schools to Senior High 

Schools or Colleges must have their destination school entered.  
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11 Step 10: Increment Student’s Proposed Years/Forms 
 

The Year End function is available on the Admin side bar.   

IMPORTANT 

Do not use speed edit to set up proposed years or forms, as this will 
prevent the Year End Process functioning correctly 

 
This function enables manipulation of the Proposed Year and Proposed Form fields.  It is not final 
until completion of the Year End process.  
 
There are three ways to increment the students who are moving up a year within the school:  
 
1. Automatic Increment of Year Groups  
2. Assign by Year/Form or 
3. Assign Individuals to a Year/Form. 
 
These functions are available through the Year End on the Admin sidebar.  

Note: Option 3 is recommended for most primary schools.  Option 2 is recommended for 
secondary schools where the student groups remain the same from one year to the next.  
Option 3 must be used for students leaving the school who are not in the Leavers’ Year. 

 

11.1 Automatic Increment of Year Groups 

If students keep the same class names but move up one year (For Example: Year 3, Form Room 1 
becomes Year 4, Form Room 1) 
 

 Select Year End in the Admin sidebar. 

 Click on the Automatic Increment of Year Groups.  
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 Click OK to proceed. 

 Note: Registration designation signifies Form. 

11.2 Assign by Year/Form 

If students' Years and Forms change such that they are both incremented by one (for example, 
Year 8, Form 8.1 becomes Year 9, Form 9.1), choose the second option from the Year End menu - 
Assign by Year/Form. 
 

 Select Year End in the Admin sidebar. 

 Click on the Assign by Year/Form. 
 

 
 

 Enter the Current Year and Form and Proposed Year and Form. 

 Click OK 

Note: Do not use this function to process Leavers.  For Leavers follow the process shown 

below in Section 11.3. 
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11.3 Assign Individuals to a Year/Form  

The third option enables each Form to be allocated a proposed Year and Form, and it also allows 
for individual students within each Form to be assigned to a different Proposed Year/Form. It is 
important to allocate a Proposed Year and Proposed Form for Leavers. 
 

 Click on Assign Individuals to a Year/Form.  

 Select the Current Year/Form to display the current student’s names in the Modifications 
pane. 

 Highlight students to be allocated a proposed year group and proposed form. 

 Select the Proposed Year Group and Proposed Form. 

 Click Update Line(s). 

Note: To allocate all students to the same Year/Form, use the Select All button.  To select 
several students hold the Ctrl key and click on the student’s names in the list.  To flag the 
Leavers, select Leaver in Proposed Year Group and Not Specified in Proposed Form. 

 

 
 
Click Save Modifications.  
Check that you have allocated a proposed year and form to each student in the form.  
Repeat for each form. 
Save the modifications and close the window when you have allocated all students. 
 
For students in the Leavers year, allocate a Proposed Year Group of Leaver and Proposed 
Form of Not Specified. 

Note: Remember to allocate Leaver and Not Specified to any student that has indicated they 

will not be returning in 2017. 

The data that has been entered in the Year End is simply proposed Years and Forms.  You can 
return to the Year End function and update the information as required. 
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11.3.1 Increment Students’ Proposed Years and Proposed Forms 

Activity: 

Admin > Year End > Assign Individuals to Year/Form 

 
We will use Assign Individuals to Year/Form function to allocate Years 4, 5, 6, 7 and Form 12.1 
to proposed years and forms. 
  
Some of the Year 4 students are going into Room 5 and some are going into Room 6 
 
Select the Current Year/Form: 4/Room 4 
Choose the Proposed Year Group – 5 and Proposed Form – Room 5 
 

 
 
Select the students from Albert, Jackie to North, Matthew  
Click Update Lines 
Click Invert Selection 
Change the Room to Room 6 
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Click Update lines 
Click Save Modifications 
Click Yes and OK 

Repeat this activity to set the Proposed Year and Form for Years 5, 6, 7 and Form 12.1 using the 
following screenshots as a guide 
 

All of the Year 5 Students are going into Year 6 in Room 7 
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All of the Year 6s are going into Year 7 in Form 7.1 

 
 

All of the 7.1 students will go into Year 8 and Form 8.2  
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All of the 7.2 students are going into Year 8 and Form 8.3 

 

 
 
Click Update Lines and Save Modifications 

  

All students in 12/12.1 will be set to Leaver as the Year Group and  Form - Not Specified 

 
 
Click Update Lines and Save Modifications 
Click Yes and OK 
Close the window 
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Admin > Year End > Assign by Year/Form 

 
We will use Assign by Year/Form to allocate proposed Years/Forms for the remainder of the 
students still to be processed. 
 

Current Year 
 

Current Form Proposed Year Proposed Form 

8 8.1 9 9.1 

8 8.2 9 9.2 

8 8.3 9 9.3 

8 8.4 9 9.4 
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12  Step 11: Print Reports Showing Proposed Years and 
Proposed Forms 

Admin > Year End > Reports Showing Proposed Year/Form 

These reports allow users to check the proposed Years and Forms prior to processing Year End.  
The Year End process will not proceed until all students have a proposed year group and form and 
the leave date and destination have been set for school leavers. 
 
Form Lists of Proposed Year/Form Groups will generate form lists for the new school year.  
These will be complete, apart from the Admissions Roll students.  Do not use proposed Year and 
Proposed Form for students on the Admissions Roll.  Students on the Admissions Roll can 
also be included in reports by checking Include Admissions Roll.  Admissions students are 
identified on such reports with an asterisk.  

Note: It is recommended that you print a list of students without a proposed Year or Form 
or without a Leave Date and Destination, the fourth option. The report lists students who 
have no proposed year and/or form.  If any have been missed, return to Step 10 and make 

the necessary changes before the End of Year is processed. 

 

IMPORTANT 

Students entered onto the Admissions Roll should be allocated to the 
Year and Form they will go into in 2017. 
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Activity: 

Admin > Year End > Reports Showing Proposed Year/Form 

 
 

 Select the End of Year Report List of students without a proposed Year or Form or without 
a Leave Date or Destination 

 

 
 

 Click Print 
 

 
 

 Click OK 

Note: If there are any students without a Proposed Year or Form or without a Leave Date or 

Destination, these will need to be allocated before the Year End Process can proceed 
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Activity: 

Admin > Year End > Reports Showing Proposed Year/Form 

 Select the last option - List of students by Proposed/Current Form and Year 
 

 
 

 Click Print and OK 
 

View the report and the students entered against their Proposed Year and Forms. 
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13 Step 12: Print Student Lists for Reference (Recommended) 
 
The Department of Education recommends the printing of Year and Form Lists for the current year 
before running the Year End process for future reference as the system does not retain the 
previous year’s data after Year End has been processed. 
 
 

Activity: 

Admin > Reports > Form Lists > Standard Form List  

 

 
 
  

Click and OK 
 

Note: This report will print all Current Form classes by default. Other Form or Year Lists can 

be printed from Admin > Reports > Roll Reports. 
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Admin > Reports > Roll Reports > Year List 

 
Highlight all Year Groups 
 

 
 

Click and OK 
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14 Step 13: Process a Back up 
 
Process a backup of the data file as described in Section 5 

IMPORTANT  

Before proceeding to the next step, repeat the backup. 

15 Step 14: Process Year End 
Processing Year End should only occur when you are ready to roll over your student data.  This 
process can only be carried out in Single User Mode, that is, all users except the person 
performing the Year End process must be logged out of Integris and the Single User Lock 
activated. 

Note: Users should negotiate a suitable time to perform the End of Year Processes.   

This will move students to their new Year and Form groups and move the students who have been 
flagged as Leavers to the Former Roll.  Each school decides whether to process End of Year after 
the end of the academic year or immediately before commencement of the new academic year. 

IMPORTANT 

If you have transferred your Admissions Roll students to the Current 
Roll before processing year end, please contact the Customer Service 

Centre on 9264 5555 or 1800 012 828 for regional callers. 
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Activity:  

File > Single User Lock 

 Type your password (‘keys’ for today’s training) 
 

 
 
Click OK 
 

 
 

Click  to ensure that no other users are logged on 

 Click Close then OK 

Note: There may be circumstances where users appear in the list but are adamant they have 
logged off correctly. In this case you may use the Gateway command to reset all user 
accounts. The instructions for this are on the next page. 

Single User lock is now activated and the icon appears in the top tool bar.  
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Activity: Resetting All Users  

 
In some circumstances it may be necessary to reset all users’ access. You must be in Single User 
Lock to perform this Gateway command. 

File > Gateway 

 
 
Enter the text RESETALLUSERS and press <Enter> 
 

 
 

 
 
Click Yes  
 

 
 
Click OK  
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Activity: Process Year End 

Admin > Year End  

This activity will move students to their new Year and Form groups and move the students who 
have been flagged as Leavers to the Former Roll.  Each school decides whether to process End of 
Year after the end of the academic year or immediately before commencement of the new 
academic year.  
 
Double Click on Process End of Year 
 

 
 
 

 
 

 Ensure the correct attendance year is selected 

 Click OK 
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 Click Yes 
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A number of messages will display while the system checks daily records and attendance data 
 

 
 

 
 

Note: If you attempt to process year end before the end of the attendance year has been 
completed the following message will appear.  End of year should be processed after the 
end of the attendance year. 

 
 
 
At the conclusion of this process the following message will be displayed: 
 

 
 

 Click Yes 

Note:  If the current UPN year is NOT set to the current year in your message box, continue 
with the Year End Process and then contact the Customer Service Centre for assistance in 
changing the UPN year.  
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 Click OK 
 

 
 
Click OK 

 

 
 

Read the Day Records FTE Warning 
Click OK 
 

Note: The processing of Year End may take from 10 to 45 minutes depending on factors 
such as processor capacity, student numbers and whether or not the Lesson Attendance 

module is loaded. 

 

Notes: Schools need to ensure that the FTE values for all Pre-Primary 
and Kindergarten students are correct before creating any Lesson 
Attendance Daily Records for the new year. See Checklist Step 18. 
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16 Step 15: Check Year End was Successful  
 

Activity 

General > Student Details 

All students’ should now have been incremented by one year.  It is important to check that this has 
been successful. 
 

 Check that Jackie Albert (the first student) is now in Year 5/ Form Room 5 

 Check that Adam Alkitik (the second student) is now in Year 10/ Form 10.1 
 

Note: If Year End has not processed successfully, contact the Customer Service Centre. 
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17  Step 16: Process Admissions Students 
Entering Admissions students (e.g. incoming Kindy or Pre-Primary students in a primary school or 
incoming Year 7 students in a secondary school for 2017) may be done at any time, but accepting 
them to the current roll should be undertaken after processing Year End. The Department of 

Education WA recommends that schools admit Admissions students to the Current Roll when the 
students arrive at the school. 
 
If you are using the School-to-School Import function to import data for students from another 
Integris school, place the incoming students on the Admissions Roll prior to the following steps. 
 

Activity: 

Admin > Speed Edit 

 Choose the Area - Acceptance Status (Admissions) 
 

 
 

Find   students on the Admissions Roll who are to be move to the current roll 
 

 
 
Click Find, Select and Yes  
 



 
 

 
 2016 Integris Admin Year End Training Notes .docx 28-Jun-16 

Page 63 of 96 

© 2016 Civica Education Pty Ltd 
 

 

Click  to highlight the students 
 

 
 

Check New Value   
 

Click Apply Changes  
 
Details are changed and M (Modified) is displayed in the Status column.  
 
Click Save 

 

 
 

Click Yes 
 

Note: If Admissions records are being edited at the time of transfer to the current roll, the 
record/s in use by other users will not be brought in to the current roll.  A message will 
appear to notify the user of the number of records not transferred to the current roll. 

This is not a single user mode function.  However, it is advisable to use single user lock 

when performing the transfer of admissions students to the current roll. 

  



 
 

 
 2016 Integris Admin Year End Training Notes .docx 28-Jun-16 

Page 64 of 96 

© 2016 Civica Education Pty Ltd 
 

 

Activity: 

Admin > Utilities > Admissions Transfer  Current Roll  

Move the students to the Current Roll. 

Note:  This would only be undertaken once the students have arrived at the school. 

 
 
Select the second option (ignoring any Entry Dates that have been entered)  
Enter the Entry Date as 1 February 2017 
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Click Next 

Note: The entry date is the student’s first day of actual attendance at school. Any entry date 
against students will be over-written with the date entered in the previous screen. 

 

Note: Students can be deselected by clicking on the X if they have not arrived at the school. 

Click Finish and OK  
If prompted to check for empty batches, click Yes 
 

 
 
Delete any empty batches 
Click on the Single User Lock Icon 
Select Restore Multi User 
  

 
 
Enter the password ‘keys’ and click OK 
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18 Step 17: Moving External Roll Students to the Former Roll  

(Discussion Only) 
 
All students on the External Roll who are not returning to the school in 2017, should be moved to 
the Former Roll using the utility Admin > Utilities > External Roll to Former Roll 
 
Edit existing External Roll Students and add a Leave Date. 

General > Student Details 

Select the External Roll 
 

 
 
Select the student/students required 
Click Edit  
Add a Leave Date on the Additional tab and click OK 
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Admin > Utilities > External Roll to Former Roll 

Double Click on the Utility 
 
 

  
 

 

 
 

Enter the Leave Date and Click OK 

 
 

 
 
Click Yes to the Warning message 
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Click Yes to remove students from their groups 

 

 
 
Click OK 
 
 
 
 
View the Students on the Former Roll 

General > Student Details 

  
  

The Original Roll to which the 
student belonged is displayed on 
the Student Details screen for 
Former Roll students. 
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19 Step 18: Changing Students’ FTE 
Some students will need to have their FTE altered. This has an impact on both Lesson Attendance 
and Census.  
 

Activity: Increasing the FTE for Pre-Primary Students 

Admin > Speed Edit  

 Select the Area – FTE and Part time status 
 

 
 

 Find the students in Year P 
 

 
 

 Click Find, Select and Yes  
 

 Click  

 Enter a New Value of 1.00 

 Click Apply Changes  
 

 



 
 

 
 2016 Integris Admin Year End Training Notes .docx 28-Jun-16 

Page 70 of 96 

© 2016 Civica Education Pty Ltd 
 

 

 Click  
 

 
 

 Click OK and Yes  
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Activity: Check the FTE for Kindergarten Students 

Decreasing the FTE  

Leave the area as FTE and Part time status 
 

 
 
Select Year Group K 
 

 
 
Click Find, Select and Yes 

Click  
 

 Edit the FTE for the Kindergarten student to 0.50  
 

 
 

 Click to Apply Change  

 Click Save, OK , Yes 
 

 

If Schools have not yet determined the part-time attendance pattern, then stop at this point. 

Click in the Custom button 
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Assign an attendance pattern by clicking on the cells where the students will NOT attend 
 

 
 

Click Use Selected for All  
 

 
 

Click OK 

 

19.1.1 Notes on Kindy Part-time Attendance Patterns 

Notes: If students are attending 0.5 but have an attendance pattern of 3 days in one week 
and 2 days in the second week, the attendance pattern should be entered as 3 days. Refer 
to the Lesson Attendance 10 Day Cycle information at the link below to set this up. If 

required, this must be done before creating Daily Records in Lesson Attendance. 

The Enforced School Closure Function is used to close school for Kindy students on the 
days they are not due to attend. This can only be done after the New Attendance Year has 

been set up. 

http://det.wa.edu.au/intranet/stims/detcms/intranet/student-information-management-system/sis-
administration/lesson-attendance-module/fact-sheets/kindy-10-day-cycle-setup 
 
 
  

http://det.wa.edu.au/intranet/stims/detcms/intranet/student-information-management-system/sis-administration/lesson-attendance-module/fact-sheets/kindy-10-day-cycle-setup
http://det.wa.edu.au/intranet/stims/detcms/intranet/student-information-management-system/sis-administration/lesson-attendance-module/fact-sheets/kindy-10-day-cycle-setup
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20 Step 19: Updating Staff Details 
When new staff commence at school, they must be entered in Staff Details.  Similarly, if staff 
leave the school, they must transferred to the Previous Employer Roll 
 

20.1 Adding New Staff 

Activity: 

Add yourself as a member of staff. 

General > Staff Details  

Click Add   
Enter the following information about yourself, tabbing between the fields: 

o Title 
o Surname * 
o First Name * 
o Gender* 
o Date of Birth * 
o Staff Code *(first three letters of your surname and your first initial) 
o ID Number* 
o Staff Type  

Note:  * indicates the field is mandatory 
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UDI – TRBWA 

 
Click on the UDI tab to enter the details of the TRBWA number.  

 
Highlight TRBWA Number 

 

 
 

Click on the Edit   
Enter the TRBWA number  

 

 
 
 
Click OK to save the number 
Click OK to save the Staff Details entered  
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20.2 Move Staff who have left to the Previous Employee Roll 

Activity: 

General > Staff Details  

Robert Charlton has left the school 
 

Search  for his records 
 

Click Move Entry to Previous Employee Roll  
 

 
 
Click Yes  
 

 
 
Enter a Leave Date and click OK 
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20.3 Update Integris Users 

20.3.1 Flag Staff who have Left as Inactive Users 

Activity: 

General > Control > Users 

 
 

Select the staff member who has left and click Edit  

Uncheck Active   
 

  
 
Click OK 
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20.3.2 Edit Expiry Dates for Continuing Users 

Activity: 

General > Control > Users 

 
 

Select a staff member who’s account needs updating and click Edit  
Enter a new Expiry Date 
 

 
 
Click OK 
 

Note: At school this would be repeated for all continuing Users. It is recommended that the 
expiry dates are not set for the very end of the year, at or the very beginning of the new 
year, as these are times when office staff are very busy. 
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21 Step 20: Update Form Descriptions 
If you have added new staff members you can now attach the names of each Form Teacher for the 
new academic year. 
 

Activity: 

General > Parameters > Form Descriptions 

 Select the Form 9.4  
 

 
 

 Click Edit   

 Click Find Form Teacher   
 

 Type ABB in the Name/Number field and click Find 
 

 
 

 Elaine Abbott’s name will be added to the Teacher field 
 

 
 

 Click on OK 
 

 Add yourself as the Form Teacher for Form 9.5 
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Activity: 

General > Parameters > Form Description 

Sometimes it is necessary to make changes to rooms for teachers and subjects. 
 

 Select Form 9.3 

 Click Edit  

 Click Find Form Room  

 Click Find  by Room Type – Computing 
 

 
 

Click  

 Highlight COMP4  Computing Lab 4 and click Select 
 

 
 

 Click Remove Link to Teacher  and Yes 

 Click Find Form Teacher  

 Type ALAN in the Name/Number field  

 Select Mark Alan 
 

 
 

 Click OK  
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22 Step 21: Repeating Students 
Ensure that for any students repeating an academic year, Repeating Current Year on the 
Miscellaneous tab in Student Details has been checked. 
 

Activity: 

General > Student Details  

 Locate Abrey Stewart’s records  
 

 Click Edit  

 Select the Miscellaneous tab 

 Under Other Information check Repeating Current Year 
 

 
 

 Click OK 
 

 

Note: This function needs to be run in Single User mode. 

23 Step 22: Assigning Family Representative Status 
The Family Representative Field flags a student as being the one who, for example, is given 
newsletters on behalf of a family.  
 
One or more members of a sibling group may be flagged as Family Representatives, although it is 
anticipated that the marker will usually be attached to the eldest or youngest sibling enrolled at the 
school. 
 
The Family Representative Field is available in the address area of the Student Details. The field is 
also included in Student Find, Speed Edit and Ad-Hoc Reporting. 
 
Users may wish to control the allocation of family representatives manually.  However, to assist in 
the flagging of representatives a utility is provided. 
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Activity: 

File > Single User Lock 

 
 
Enter Keys and click OK 
 

 
 
Click OK again 
 

Admin > Utilities > Assign Family Representatives 

Enter the following settings:  
 

 
 

 Click OK and Yes 
 

 

Click the Single User mode icon  
Click Restore Multi-user 
Enter Keys and click OK 
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24 Step 23: Print State Archives Report 
As part of the End of Year Process, schools are required to produce the State Archives Report 
which will ensure schools comply with the State Records Act 2000. 
 
As SIS is not a Records Management compliant system and in the absence of an electronic 
records and document management system for schools, enrolment records for left students held 
within SIS are required to be produced in a hardcopy format.    
 
The process will include: 

Producing the relevant printout (this will list the various student enrolment details for left 
students only). 

Saving the hardcopy report in a file created in the 859 category of the School Filing System 
e.g., 859/nn STUDENTS – ENROLMENTS – Enrolment details of students who left [name 
of school] during the current year. 

Retaining the file as an archival record and holding for one year. 
 
At the end of one year, close the file and process it in accordance with the procedures in the 
Records Management Manual for School, College and Campus Records relating to the transfer of 
archival records to the State Records Office of Western Australia. 
 

Activity: 

Admin > Reports > Ad Hoc Reports 

 Open Ad Hoc Reports folder 
 

 
 

 Highlight State Archives Report 

 Add 2016 to the Main Title, as shown above 

Note: The report will only need to show students who have left school in the current 

calendar year. 
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 Click New Query 
Set Roll Status to: n/s 
 

 
 
Click on the Dates tab  

 

 Select the students within the year’s Leaving Date range in 2016 
 

 
 

 Click Find, Select and Yes 

 Print the report to the screen 

 Close Reports 

 

 

Note:  A copy of this report needs to be saved to the 859 category of the School Filing 
System, that is 859/nn STUDENTS > ENROLMENTS > Enrolment details of students who left 
[name of school] in 2016. 

Retain this file as an archive record and store for one year.  At the end of one year, close 
the file and process it in accordance with the procedures in the Records Management 
Manual for School, College and Campus Records relating to the transfer of archival records 
to the State Records Office of Western Australia. 
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25 Step 24: Set up New Attendance Year  
Setting up the New Attendance Year only applies to schools that currently use the Lesson 
Attendance module. 
 
Ensure the datafile has been backed up before proceeding. 
 
Secondary schools, before proceeding it is important that you ensure the school’s timetable 
specifies which periods are AM and which are PM in Timetabling > Timetable Setup > Timetable 
Cycles > Master Period Structure. 

Note: If you require assistance with creating the new attendance year please contact the 
Customer Service Centre.  
 
Metro 9264 5555 

Count 1800 012 828 

 

Activity: Set up the New Attendance Year 

Lesson Attendance > Parameters > Create New Attendance Year 

View pre-requisites to setting up the new Attendance Year in the New Lesson Attendance Year 
window 

 

 
 
 
Click Proceed  
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Enter the following dates  

 

 
 
 
Click OK 
 

IMPORTANT:  
The Attendance Year must ALWAYS commence on a Monday.  

If an FTE Warning Report opens at this point check the information on 
page 90. 
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Click Yes 

Note:  Schools only copy the previous year’s set-up if the Period Availability Structures and 

Year Groups remain the same from one year to the next 

The cycles reflect the term data entered in the School Diary.  Cycle descriptions can be edited to 
display in Day View with the terminology used in your school. 
 
Place your cursor immediately before Week 1  
Type Term 1 and a space 
Highlight Term 1and a space - <Ctrl> +C to copy 
Place your cursor immediately before Week 2  
<Ctrl> + V  to paste 
Continue for all remaining weeks in Term 1 
Overtype Week 11 and 12  with Holidays 
Overtype Week 13 with Term 2 Week 1 

 

 
 

Note: In school, you would continue to edit the descriptions for the entire year. 
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Click Save and Yes 

 

 
 

 

Click  
 

 
 
Click Yes 

View the available period structures 
 

 
 

Click  
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Note: Alternative period structures could be added if required. 

 
 

Click Yes 
 

Check the box for K and ensure Year Groups K to 12 are selected to be included in Lesson 
Attendance 

 

 
 
Click Next 
Add the Primary Period Structure to include the K students 
Select the appropriate Period Structure for each year group including Kindergarten as Primary 

and Year 7 – 12 as Timetabling 
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Click Save and Finish 

 

 
 
Click Yes  
 

 
 
 
Click OK  
 

IMPORTANT  

Year 11 and 12 End Dates will need to be edited once they have been 
determined for 2017 through - Lesson Attendance > Parameters > Year 

Groups. 
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25.1.1 Create New Year FTE Warning 

If Kindy and/or Pre-Primary students are included in the Lesson Attendance module and any of 
these students in your Datafile do not have an expected FTE, a Report will run to display these 
students.  
 
Student FTE values should be corrected before creating the New Attendance Year. The Report will 
display any Kindy students that have an FTE value of 1.00 or any students from Pre-Primary 
upwards that have an FTE Value of less than 1.00 
 
A Sample Report is shown below. 
 

 
 
The following warning will also display 
 

 
 
Clicking on Yes will allow you to go back and edit any FTE Values for students that are not correct. 
Clicking on No allows the User to complete the set-up of the New Year. 
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26  Step 25: Notification of Transfer 
Schools are reminded that they must provide written or electronic notification of the date an 
enrolment commences to the school where the new student was previously enrolled.  This includes 
notification to Primary schools when students are enrolling in Secondary school for the first time. 

 

Activity: Print  a List of New Enrolments 

Admin > Speed Edit 

Confirming Enrolment to the Previous School 

Select Previous School  from the Area drop-down menu 
 

 
 

Open the Student Search window   and select the Current Roll  
 

 
 
In the Dates tab, enter an Entry date of 1 FEB 2016   

Note:  When this activity is performed as part of the year end activities, the date range 

would commence from the first day of the school year to the current date. 

 
 

Click on Find, Select  and Yes 
 
A list of students and their previous schools will be displayed. 
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Click on the Value header and scroll down 
 

 
 

To print the list, select the printer icon   
 

Note: A Transfer Note or List of Students must be sent to each school identified in the 

Previous School List advising that the student is now enrolled at your School. 
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27 Step 26: Checking Student’s Destination School 
Schools must also resolve the destination of each leaving student, including those students making 
the transition from Primary to High School, Middle School or Senior Campus.  To assist in this 
process, schools can print a list of all students on the Former Roll displaying their destination 
school. 
 

Activity: Check Student’s Destination School 

Admin > Speed Edit 

Select Destination from the Area drop-down menu 
 

 

Open the Student Search window  and select the Former Roll  
 

 
 
In the Dates tab, enter a Leaving Date range of the previous school year 

 

 
 

Click Find, Select and Yes 
 
A list of students and their destination school will be displayed 

To print the list, select the printer icon   
 
Where an advice of transfer has not been received for a particular student, the school should follow 
up with the parent(s) to determine the destination and confirm the enrolment with the new school.  
Where schools are unable to verify student destination following investigation, the child may be 
considered ‘whereabouts unknown’ and should be referred to the Student Tracking Officer through 
the District Attendance Coordinator. 

Note: Further information outlining this process can be found at http://bswb.det.wa.edu.au 
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28 Step 27: Purge the Audit Trail 
Electronic Records of user activity are purged to a text file and saved, then deleted from the 
software. The previous year’s records are kept on the system, however those for the year before 
last year are purged. 
 

Activity: 

General > Control > Audit 

Select All Users and Entries in the date range. 
Enter the date range for the calendar year e.g. 01 JAN 2015 to 31 DEC 2015  
 

 
 

Click   
 

 
 
Click Yes and Yes to the second message 

 

 
 
Save to C:\Keys\Integris\Outbox with the file name: 2015 Audit Log 
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29 Support 
Should you require support please contact the Customer Service Centre (CSC) at the 

Department of Education. 
 
Contact details below: 

29.1 Phone (CSC) 

Metro: 9264 5555 
Country: 1800 012 828 
 
Please be prepared to supply your ID number, contact details and a brief description of the 

problem. 

29.2 Fax (CSC) 

9264 4701 
 
Please include your ID number, contact details and a brief description of the problem. 

29.3 Email (CSC) 

customer.service.centre@education.wa.edu.au 
 
Please include your ID number, contact details and a brief description of the problem. 
 

30 Online Manuals and Training Notes 

30.1 Civica Education 

Online manuals and training notes are available to download in PDF format from the Civica 
Education website. 
 
http://www.civicaeducation.com.au/ 
 
Select Integris Support. 
Log in to Western Australian SIS Schools. 
Username: school 
Password: help 
 

30.2 STIMS Project 

The Department’s Student Information Management Project (STIMS) website has numerous 
factsheets and support documents for all SIS Administration modules. 
 
http://www.det.wa.edu.au/intranet/stims  
 
Links to the Integris Manuals are also available from the STIMS website or by going to Help within 
Integris. 
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